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SUMMARY:  21 
The protocols describe high-performance liquid chromatography methods coupled to refractive 22 
index or mass spectrometric detection for studying metabolic reactions in complex lysate-based 23 
cell-free systems. 24 
 25 
ABSTRACT:  26 
Engineering cellular metabolism for targeted biosynthesis can require extensive design-build-27 
test-learn (DBTL) cycles as the engineer works around the cell’s survival requirements. 28 
Alternatively, carrying out DBTL cycles in cell-free environments can accelerate this process and 29 
alleviate concerns with host compatibility. A promising approach to cell-free metabolic 30 
engineering (CFME) leverages metabolically active crude cell extracts as platforms for 31 
biomanufacturing and for rapidly discovering and prototyping modified proteins and pathways. 32 
Realizing these capabilities and optimizing CFME performance requires methods to characterize 33 
the metabolome of lysate-based cell-free platforms. That is, analytical tools are necessary for 34 
monitoring improvements in targeted metabolite conversions and in elucidating alterations to 35 
metabolite flux when manipulating lysate metabolism. Here, metabolite analyses using high-36 
performance liquid chromatography (HPLC) coupled with either optical or mass spectrometric 37 
detection were applied to characterize metabolite production and flux in E. coli S30 lysates. 38 
Specifically, this report describes the preparation of samples from CFME lysates for HPLC analyses 39 
using refractive index detection (RID) to quantify the generation of central metabolic 40 
intermediates and by-products in the conversion of low-cost substrates (i.e., glucose) to various 41 
high-value products. The analysis of metabolite conversion in CFME reactions fed with 13C-42 
labeled glucose through reversed-phase liquid chromatography coupled to tandem mass 43 
spectrometry (MS/MS), a powerful tool for characterizing specific metabolite yields and lysate 44 
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metabolic flux from starting materials, is also presented. Altogether, applying these analytical 45 
methods to CFME lysate metabolism enables the advancement of these systems as alternative 46 
platforms for executing faster or novel metabolic engineering tasks.  47 
 48 
INTRODUCTION:  49 
Limitations in engineering microbes for chemical production can be addressed by recapitulating 50 
biochemical reactions in vitro where competing cellular survival functions are absent1. Moreover, 51 
the open reaction environment (i.e., absence of a cell membrane) is more amenable to 52 
manipulation and is easier to monitor compared to live cells. This foundational concept of cell-53 
free metabolic engineering (CFME) has been elegantly demonstrated by the reconstitution of 54 
metabolic pathways to synthesize valuable chemicals like hydrogen and monoterpenes with 55 
production metrics that are orders of magnitude higher than presented in microbial cell factories 56 
thus far1–3. Methods for purifying whole pathways, however, are currently constrained by time 57 
and cost. Alternatively, cell-free metabolic systems can be derived from crude cell extracts 58 
through rapid and inexpensive methods relative to whole pathway reconstitution4. The central 59 
metabolism that is retained in cell extracts can be supplemented with energy substrates (e.g., 60 
glucose and enzymatic cofactors) and salts in buffered solutions to generate central metabolic 61 
precursors for over 24 h5,6. Adding exogenous enzymes to the lysate-based CFME reaction allows 62 
more complex bio-transformations of glucose into more valuable chemicals at high titers4,6,7. 63 
Although yield tends to be compromised in these systems due to their cell-like metabolic 64 
complexity, unique methods to curate lysate proteomes for higher yield conversion have been 65 
and are being developed7,8. 66 
 67 
The ease of carrying out metabolic transformations in lysate-based cell-free systems makes these 68 
excellent platforms for either moving chemical manufacturing outside of the cell altogether or 69 
for prototyping new pathways with high throughput before building and testing these designs in 70 
vivo2,9. For either application, tools for monitoring metabolic conversions or observing overall 71 
alterations to metabolic flux in lysates are integral to the advancement of CFME. High-72 
performance liquid chromatography (HPLC) can be used to separate the chemical constituents of 73 
CFME reactions with high-resolution and can be coupled to optical or mass-spectrometric 74 
detectors for metabolite quantification5,10. The underlying principle of HPLC is that analytes 75 
dissolved in a solvent (i.e., mobile phase) and pumped through a column will interact with the 76 
specific column packing material (i.e., stationary phase)11. Depending on their chemical 77 
properties, these analytes exhibit varying retention times before they are eventually eluted from 78 
the stationary phase and carried by the mobile phase to a detector. This report details the 79 
preparation and analysis of E. coli lysate-based CFME reactions through HPLC-based methods 80 
leveraging RID and MS/MS detection.  81 
 82 
HPLC coupled to refractive index detection (HPLC-RID) is a generally accessible method for quickly 83 
identifying central metabolic precursors and end-products. Briefly, RID measures how analytes 84 
change the deflection of light by the mobile phase12. RID signals corresponding to target analytes 85 
in samples can then be quantified by comparisons with RID signals of standard solutions. In CFME 86 
applications, this mode of detection has been most commonly used with HPLC columns that 87 
separate compounds based on a combination of size exclusion and ligand exchange mechanisms, 88 



   

or ion-moderated partition chromatography5,6,8,13. This particular technique is used to quickly 89 
quantify the consumption of sugar substrates like glucose as well as the formation of 90 
fermentation products like succinate, lactate, formate, acetate, and ethanol in lysate-based 91 
CFME reactions8. Recording the concentration changes of these compounds via HPLC has been 92 
useful for both elucidating the potential of crude cell extracts to pool central metabolic 93 
precursors and understanding how pathway flux is redirected through fermentative pathways 94 
during complex metabolic conversions from glucose in lysates6,8,14. Seminal CFME studies in E. 95 
coli cell extracts confirm that fermentation compounds accumulate as end-products of glucose 96 
catabolism and also occur as unwanted by-products in lysates that overexpress exogenous 97 
enzymes6,15. It is suggested that fermentative metabolism plays a necessary role in regenerating 98 
redox equivalents of cofactors (i.e., NAD(P)H and ATP) to sustain glycolytic reactions8. Hence, an 99 
HPLC-based optical detection method designed to separate fermentation products is a useful and 100 
commonly applied tool when executing various lysate-based CFME tasks. 101 

 102 
CFME can be implemented to accumulate metabolic end-products that are not carbohydrates, 103 
organic acids, or alcohols4. The measurement of intermediates that are consumed as quickly as 104 
they are synthesized may also be desirable10.  While HPLC-RID is accessible in terms of cost and 105 
difficulty, this method is constrained by its ability to only distinguish metabolites based on 106 
retention time. A broader range of metabolites can be analyzed when liquid chromatography is 107 
coupled to MS/MS detection (LC-MS/MS)16. By this method, analytes in the mobile phase are 108 
ionized and differentially detected based on each molecule’s mass and charge properties. 109 
Knowledge of both the metabolite’s mass-to-charge (m/z) ratio and retention time on the column 110 
thus facilitates the separation of most metabolic intermediates and end-products with high 111 
resolution16. This detection technique can also be coupled to nano-liquid chromatography, which 112 
affords much lower flow rates and sample injection volumes, allowing more sensitive detection 113 
of small molecules in the complex lysate background17. LC-MS/MS can additionally be applied 114 
with isotope labeling since incorporated labels impart changes in analytes’ m/z values18. 115 
Timepoint measurements extracted from a CFME reaction supplemented with a 13C6-glucose 116 
substrate can thus determine the end- or by-products derived specifically from supplemented 117 
glucose. Although this isotope tracing method is not yet commonly applied in CFME studies, it is 118 
a powerful tool for understanding metabolic conversions in lysate-based CFME systems, 119 
specifically since salt counterions (i.e., acetate and glutamate) in these reactions are also 120 
catabolized as secondary substrates19. Leveraging this technique can thus draw a comprehensive 121 
picture of glucose metabolism in lysates, which to this day is not completely understood. Here, 122 
the protocol details a method for nano-liquid chromatography coupled to nanoelectrospray 123 
ionization (nano ESI) MS/MS that can be used to interrogate a possible model of glucose 124 
metabolism, specifically in E. coli lysates (Figure 1). The model is based on reports of fermentative 125 
pathways and the pentose phosphate pathway being active in E. coli lysates derived from strains 126 
grown in rich media5,6,8,14. The technique is additionally used to investigate amino acid production 127 
since current knowledge on amino acid anabolism from glucose in lysates is limited to a few 128 
examples such as the synthesis of aromatic amino acids7. Given the mostly polar nature of end-129 
products and intermediates in these pathways (i.e., organic acids, sugar phosphates, and amino 130 
acids), reverse-phased liquid chromatography was utilized here.  This technique separates polar 131 
compounds by elution from a nonpolar stationary phase. These compounds were then ionized 132 



   

by nano ESI in negative ion mode which permits the detection of analytes with at least one 133 
negative elementary charge and is thus useful for detecting acidic compounds. This technique is 134 
employed here to analyze glucose-derived 13C-incorporating metabolites and demonstrates the 135 
utility of LC-MS/MS for understanding glucose metabolism in lysates. 136 
  137 
PROTOCOL:  138 
 139 
1. Starting, stopping, and processing time course CFME reactions for HPLC-RID quantification.  140 
 141 
1.1. Thaw previously prepared E. coli lysates and prepare the rest of the reaction components on 142 

ice. 143 
 144 
NOTE: The lysates reported here were derived from E. coli BL21DE3-Star grown in 2xYPTG (1.8 % 145 
glucose) media to mid-log phase.  146 
 147 
1.1.1. Prepare an appropriate volume of filter-sterilized (0.20 μm pore filter) S30 buffer (1 M Tris-148 
OAc adjusted to pH 8.2 with glacial acetic acid, 1.4 M Mg(OAc)2, and 6 M KOAc). 149 
 150 
1.1.2. Prepare an energy mix containing glucose, glutamate salts, ATP, Coenzyme A, NAD+, Bis-151 
Tris buffer, and dipotassium phosphate in the S30 buffer. Final concentrations in the desired 152 
reaction volume used to prepare CFME reactions here were 100 mM glucose, 18 mM magnesium 153 
glutamate, 15 mM ammonium glutamate, 195 mM potassium glutamate, 1 mM ATP, 0.2 mM 154 
Coenzyme A, 1 mM NAD+, 150 mM Bis-Tris, and 10 mM dipotassium phosphate. 155 
 156 
1.2. Combine the components in 1.5 mL microcentrifuge tubes to prepare final reactions with 4.5 157 
mg/mL of total lysate protein. Here, CFME reactions were prepared with final volumes of 50 μL 158 
in triplicate per timepoint. Incubate the reactions at 37 °C for their respective timeframes. 159 
 160 
NOTE: Work fast and add lysate as the final component of the reaction mix to prevent premature 161 
metabolic reactions with glucose and glutamate salts. Minimal glucose consumption can occur 162 
depending on how long reaction mixes are incubated on ice.  163 
 164 
1.3. Terminate the reactions and process the samples for HPLC-RID analysis. 165 
 166 
1.3.1. To terminate the triplicate reactions at their appropriate time points, immediately add an 167 
equal volume of 5% trichloroacetic acid to each sample’s final reaction volume (i.e., 50 μL of 5% 168 
trichloroacetic acid to a 50 μL reaction). Dilute each sample with sterile water at 2x the reaction 169 
volume (i.e., 100 μL).  170 
 171 
1.3.2 To recapitulate time zero, mix the same volume of 5% trichloroacetic acid as the total final 172 
reaction volume (i.e., 50 μL) with the lysate prior to adding the rest of the reaction components. 173 
This acidification step precipitates lysate enzymes before they significantly metabolize glucose.  174 
 175 
1.3.3. Vortex the samples and centrifuge on a benchtop microcentrifuge at 11,600 x g for 5 min 176 



   

and transfer supernatants containing the organic analytes to clean tubes. Store the samples at -177 
20 °C if HPLC analyses are to be conducted on a different day. Ensure to thaw the stored samples 178 
on ice before proceeding to the next step. 179 
 180 
1.3.4. Filter each supernatant with a 0.22 µm pore filter. As an alternative to syringes, use 181 
centrifuge tube filters and centrifuge the supernatants at 16,300 x g for 1 min.  182 
 183 
1.3.5. Transfer each filtrate to a clean HPLC glass vial. Load vials onto the HPLC autosampler tray. 184 
 185 
1.4. Prepare samples for standard curve generation. 186 
 187 
1.4.1. Prepare a stock solution of all target analytes dissolved in S30 buffer at equimolar amounts 188 
above the starting concentration of glucose in the CFME reactions. Here, a stock solution 189 
consisting of 150 µM glucose, succinate, lactate, formate, acetate, and ethanol, was prepared. 190 
Perform 1:1 (v/v) serial dilutions from the stock solution to obtain triplicate 50 μL solutions with 191 
final concentrations ranging from 0 µM to the stock concentration (i.e., 150 µM). 192 
 193 
1.4.2. Dilute each solution with 50 μL of 5% trichloroacetic acid and 100 μL of sterile water. 194 
Repeat steps 1.3.4–1.3.5. 195 
 196 
NOTE: Run solutions for standard curve generation with each batch of samples to ensure accurate 197 
quantification of metabolite concentrations. 198 
 199 
2. Preparing the HPLC system for metabolite detection.  200 
 201 
2.1. Under a fume hood, prepare a sterilized 5 mM sulfuric acid solution from deionized and filter-202 
sterilized water. Add ~550 µL of a 98% HPLC grade sulfuric acid solution to 2 L of water to prepare 203 
5 mM sulfuric acid. 204 
 205 
CAUTION: Sulfuric acid is a hazardous chemical, and working under a fume hood with proper lab 206 
PPE prevents inhalation, skin contact, and eye contact. Concentrated sulfuric acid reacts 207 
vigorously with water and should be added directly to water, not the other way around. Store in 208 
a cool, dry area away from direct sunlight and follow proper waste disposal measures set by the 209 
laboratory. 210 
 211 
2.2. Keep the 2 L bottle of 5 mM sulfuric acid incubated in a water bath next to the HPLC 212 
instrument. Set the water bath to 35 °C. Place tubing with a solvent filter in the solvent bottle 213 
and attach the other end to a degasser module in line with the pump module.   214 
 215 
NOTE: Purging the system with a freshly prepared solvent prior to installing the column is good 216 
instrument handling practice. 217 
 218 
2.3. Equip the HPLC instrument with the HPLC column in line with the RID module. Place the 219 
column in the 35 °C water bath if a column thermostat is not available.  220 



   

 221 
2.4. Prepare the RID module for analysis at 35 °C in OpenLab CDS (Online) 2.15.26 software 222 
installed on the system computer.  223 
 224 
2.4.1. In the View menu, select the Method and run Control View. Right-click on the Pump 225 
Module > Method. Set the flow rate to 0.55 mL·min-1 and select the On button to initiate the 226 
pump. 227 
 228 
NOTE: If the column was in storage prior to being equipped on the HPLC, ramp up the flow rate 229 
to 0.55 mL·min-1 after equilibrating the column following the manufacturer’s instructions. 230 
 231 
2.4.2. Right-click on the panel corresponding to the RID Module > Method. Set the temperature 232 
of the RI detector module to 35 °C and select On to start warming up the RI detector module. 233 
 234 
2.4.3. Right-click on the panel RID Module > Control. Select On for the Purge Reference Cell for 235 
at least 15 min when using a fresh solvent or 1 h if different solvents flowed through the RI 236 
detector prior to this setup. Click on the On button. 237 
 238 
NOTE: Keep the pump and RI detector On to achieve a stable baseline on the online plot. This is 239 
affected by temperature fluctuations in the laboratory and can take up to 4 h or longer. Keep the 240 
system On overnight prior to sample loading.  241 
 242 
3. Creating a method for the isocratic HPLC separation of organic fermentation products in 243 
OpenLab (online).  244 
 245 
3.1. From the menu bar, select Method > New Method. Select Method > Save Method as 246 
[MethodName].M. Select Method > Edit Entire Method > Instrument/Acquisition 247 
 248 
3.2. Within the Binary Pump tab, set the flow to 0.55 mL·min-1. Under Solvents, select the letter 249 
corresponding to the solvent input on the pump module and set it to 100% for isocratic elution. 250 
Set Pressure Limits to 0 and 400 bar and input 30 min as the Stoptime. 251 
 252 
3.3. Within the Sampler tab, set the Injection Volume to 50 μL. Select the As Pump/No Limit 253 
option under Stoptime. Set the Advanced Auxillary Settings for Draw Speed, Eject Speed, and 254 
Draw Position to 200 μL·min-1, 200 μL·min-1, and -0.5 mm. 255 
 256 
3.4. Within the RID tab, set Optical Unit Temperature to 35 °C. Under Signal, select Acquire for 257 
Signal and >0.2 min for Peakwidth. Select the As Pump/Injector option for Stoptime. 258 
 259 
3.5. Under Advanced within the RID tab, set Analog Output to 5% Zero Offset and 500,000 nRIU 260 
for Attenuation. Select the Positive option for Signal Polarity and the On option for Automatic 261 
Zero Before Analysis.  262 
 263 
3.6. Save the method by selecting Method > Save Method. Load the method by selecting Method 264 



   

> Load Method > [MethodName].M. 265 
 266 
4. Creating a sequence table for autosampling and start the HPLC-RID system for data 267 
acquisition.  268 
 269 
4.1. From the menu bar, select Sequence > New Sequence Template. Select Sequence > Save 270 
Sequence Template as [SequenceTemplateName].S.  271 
 272 
4.2. Select Sequence > Sequence Table. Append ‘n’ rows corresponding to ‘n’ vials, then input 273 
vial positions and sample names under Vial and Sample Name, respectively, according to their 274 
arrangement on the autosampler tray. Select the Method generated in step 3 from the Method 275 
Name dropdown menu and input 50 μL as Inj/Vial (Injection per Vial) for each row.  276 
 277 
4.3. Click Apply and save the sequence template by selecting Sequence Template > Save 278 
Sequence Template. Ensure the sequence template is loaded by selecting Sequence > Load 279 
Sequence Template > [SequenceTemplateName].S. 280 
 281 
4.4. After achieving a stable baseline on the online plot, right-click the panel RID Module > 282 
Control > Off Recycling Valve to direct the solvent flow through the RID detector to waste. To 283 
start data acquisition, select  Sequence from the menu bar,  Sequence > Run.  284 
 285 
5. Extracting and analyzing data post-run.   286 
 287 
5.1. Select Data Analysis view from the View menu. Locate the Sequence Filename from the File 288 
List on the left-hand side of the screen. On the center panel on the screen, go to the Signal View 289 
Selection > RID Signal to view the sample chromatograms. 290 
 291 
5.2. Select a row corresponding to a high concentration standard sample from the top panel on 292 
the screen. Take note of the retention times for the target analyte peaks on the displayed 293 
chromatogram. Peaks corresponding to the target analytes will be arranged along the retention 294 
time axis as glucose, succinate, lactate, formate, acetate, and ethanol (Supplemental Figure 1).  295 
 296 
NOTE: The first large peak on the chromatogram corresponds to trichloroacetic acid. Its RI units 297 
should be consistent across all standard curve samples. Validate the retention time of each target 298 
analyte by running each compound as a separate sample.  299 
 300 
5.3. Extract peak areas for each target analyte from chromatograms of the standards and the 301 
reaction samples.  302 
 303 
5.3.1. Discern whether the peaks-of-interest are well integrated by the software. Draw the red 304 
line as the base of each peak to obtain an accurately integrated area under the curve. If automatic 305 
integration fails (i.e., red line is askew), select the Manual Integration button from the 306 
Integration Tool Set and manually draw a peak base to integrate the peak area.  307 

 308 



   

NOTE: If manual integration must be performed for a target analyte in one sample, keep 309 
consistent and manually integrate the same analyte across all samples.  310 
 311 
5.3.2. Select the Cursor tool from the Common Tool Set to click on properly integrated peaks. 312 
The peak area and the corresponding reaction time of the selected peak will be highlighted as a 313 
table row on the bottom panel of the screen.  314 
 315 
5.3.3. To export peak areas, select File > Export > Integration Results.  316 
 317 
5.4. Quantify the target analyte concentrations using standard curves.  318 
 319 
5.4.1. Plot peak area values vs. known concentrations of samples in a spreadsheet. Right-click on 320 
the plotted data, Add Trendline > Format Trendline > Display Equation on Chart.  321 
 322 
5.4.2. In a separate spreadsheet, use the equations of standard curve trendlines to convert peak 323 
area values to concentrations for every analyte from each sample. Calculate the average peak 324 
areas and standard error values across triplicates for data visualization.  325 
 326 
6. Starting, stopping, and processing time course isotope tracing CFME reactions for LC-MS/MS 327 
quantification.  328 
 329 
6.1. Set up triplicate reactions per time point (except time zero) on ice as described in 1.1–1.2. 330 
However, instead of glucose, use a final concentration of 100 mM 13C6-glucose in the reactions. 331 
Incubate the reactions at 37 °C for 1 h, 2 h, and 3 h.   332 
 333 
6.2. To terminate, flash freeze the reactions in liquid nitrogen and store them at -80 °C.  Skip this 334 
storage step for same-day analysis. 335 
 336 
NOTE: Trichloroacetic acid was not used to stop reactions due to interference from the acid when 337 
detecting some central carbon metabolites via LC-MS/MS. Instead, extraction solvent containing 338 
formic acid (step 6.3) was used to precipitate metabolic proteins since formic acid’s mass is below 339 
the detection limit of the reported MS/MS method. 340 
 341 
6.3. Prepare 50 mL of the extraction solvent. Combine and vortex 20 mL of acetonitrile, 20 mL of 342 
methanol, and 10 mL of water (all LC-MS grade) in a 50 mL centrifuge tube along with 0.199 mL 343 
of formic acid to make a 0.1 M solution. Chill the solvent to 4 °C during extraction and store the 344 
solvent at -20 °C when not in use. 345 

 346 
6.4. Processing samples for LC-MS/MS analysis 347 
 348 
6.4.1. On the day of analysis, pipette an equivalent volume of the extraction solvent (i.e., 50 μL) 349 
to each sample. If the samples were frozen, add the extraction solvent before the samples 350 
completely thaw out to prevent the reactivation of glucose metabolism. Perform all sample 351 
processing steps on ice. 352 



   

 353 
6.4.2. To recapitulate time zero, pipette the final volume of extraction solvent (i.e., 50 μL) to an 354 
appropriate volume of lysate for the desired final concentration in the reaction (i.e., of 4.5 mg/mL 355 
in 50 μL reaction volume). Add the rest of the reaction components as in step 1.2. This 356 
acidification step precipitates lysate enzymes before they significantly metabolize glucose. 357 
 358 
6.4.3. Incubate the samples in extraction solvent on ice for 30 min with gentle shaking, then 359 
centrifuge the samples at 21,000 x g for 15 min at 4 °C to separate the supernatant from the 360 
precipitated protein. Transfer 50 μL of the supernatant to autosampler vials and load the vials 361 
onto the tray within the 4 °C autosampler. Store the rest of the supernatant at -20 °C for future 362 
analyses. 363 
 364 
7. Setting up the LC system for LC-MS/MS analysis.  365 
 366 
7.1. Prepare 1 L of Solvent A by completely dissolving 77.08 mg of ammonium acetate in 950 mL 367 
of water and 50 mL of isopropanol. Prepare 1 L of Solvent B with 650 mL of acetonitrile, 300 mL 368 
of water, and 50 mL of isopropanol along with 77.08 mg of ammonium acetate. Ensure that all 369 
solvents are LC-MS grade.  370 
 371 
7.2. Connect the solvent bottles containing Solvents A and B to the pump module. Purge the 372 
system at a high flow rate to remove/limit any air contamination that may have occurred during 373 
the equipment of the solvents to the LC system. 374 
 375 
7.3. Equip the system with a C18 reversed-phased column (30 cm column length, 75 µm inner 376 
diameter, and 5 µm particle diameter). Condition the column to the LC-MS system by flowing 377 
100% solvent B and slowly flowing up Solvent A to 100%. 378 
 379 
NOTE: Column tips were prepared in-house using a micropipette puller and packed with pressure 380 
cells and helium. 381 
 382 
8. Creating a method on LC-MS/MS data acquisition and interpretation software for the LC 383 
system linked to Fourier Transform and Ion Trap Mass Spectrometers.  384 
 385 
8.1. Open the Tune Plus software to edit a tune file for the MS method. 386 
 387 
8.1.1. From the File on the menu bar, open a preinstalled negative mode tune file.  388 
 389 
8.1.2. Select ScanMode on the menu bar, then select Define Scan Window. Set the microscan 390 
time setting for MSn to 1 for both Ion Trap and FT.  391 
 392 
8.1.3. Go to settings for Nano-ESI Source and set Spray Voltage to 4 kV. Modulate this until an 393 
acceptable electrospray is generated; typically, acceptable electrospray can be achieved within 394 
the range of 2–5 kV.   395 
 396 



   

8.1.4. Save the tune file.  397 
 398 
8.2. Generate a new LC method using the Setup Wizard of the instrument’s data acquisition and 399 
interpretation software. Open Roadmap > Sequence Setup > Wizard. Since these methods do 400 
not require the usage of a column heater, skip the Temp Control step.  401 
 402 
8.2.1. Under Flow Gradient Pump Options, select Multistep. In the next window, insert 7 lines 403 
and set the flow rate for each row to 0.1 mL·min-1. Input the following parameters for each row: 404 
from 0–3 min, deliver 100% solvent A; from 3–9 min, introduce a gradient from 100% solvent A 405 
to 20% solvent B; from 9–19 min, introduce a new gradient from 20% solvent B to 100% solvent 406 
B; from 19–27 min, hold at 100% solvent B; from 27–28 min, set the gradient back to 100% 407 
solvent A; from 28–44 min, rinse and recondition of the column for subsequent runs by holding 408 
at 100% solvent A. Include a final step to lower the flow rate to 0.03 mL·min-1 upon completion 409 
of the run to conserve the solvent when the LC is not in use. 410 
 411 
8.2.2. Apply Default settings for Sampler Options > Pump Pressure as the Acquisition Option and 412 
use Default Acquisition Time and use Default Pump Pressure options.  413 
 414 
8.3. Create an MS/MS method by selecting the Orbitrap Velos Pro MS icon from the sidebar on 415 
the Instrument Setup window. 416 
 417 
8.3.1. Click on New Method > Data Dependent MS/MS. Set Acquire Time to the length of the LC 418 
run (i.e., 44 min), Segment to 1, and Scan Events to 11. For Tune File, select the edited file from 419 
step 8.1.  420 
 421 
NOTE: The first event is an MS1 precursor scan using the Fourier Transform MS (FTMS). The 422 
succeeding 10 events will be MS2 scans selecting the 10 most intense and unique ions in each 423 
precursor scan for MS2 fragmentation. 424 
 425 
8.3.2. For Event 1, under Scan Description set Analyzer to FTMS and Polarity to Negative. Under 426 
MSn Settings, use a Resolution of 30,000 and a Normalized Collision Energy of 35 V. Set Scan 427 
Ranges to 50 m/z for first mass and 1800 m/z for last mass to capture small molecules.  428 
 429 
8.3.3. For events 2 through 11, under Scan Description set Analyzer to Ion Trap. Select 430 
Dependent Scan and click on Settings > Global > Dynamic Exclusion and select Enable; set a 30 431 
s repeat duration and 120 s exclusion duration to eliminate repeat scans in proximity.  432 
 433 
8.3.4. Go to Scan Event settings and set Mass Determined from Scan Event to 1 for all MS2 events 434 
(2 through 11). To scan for the top 10 most intense ions, set each MS2 scan event to detect an 435 
nth Most Intense Ion from 1st to 10th. Therefore, set Event 2 to detect 1 as the nth Most Intense 436 
Ion, event 3 to detect 2, and so on.  437 
 438 
8.3.5. Close the setup window and go to File > Save As [Method_Name].meth.  439 
 440 



   

NOTE: For general use, maintenance, and calibration of the LC instrument and mass 441 
spectrometer, refer to the operating instructions and manuals supplied by the manufacturer. 442 
 443 
9. Setting up a run sequence and starting the LC-MS/MS run. 444 
 445 
9.1. Set up a Run Sequence using the LC-MS/MS system’s data acquisition and interpretation 446 
software. Within Roadmap > Sequence Setup, right-click on the table to insert as many rows as 447 
samples.  For each row, set the Inj Vol to 5 μL and the Position to the vial’s respective position 448 
on the autosampler tray. Input file names as sample names and set the desired file path for run 449 
results.  450 
 451 
NOTE: Blank vials containing Solvent A can be run at the start of the sequence and between each 452 
set of triplicate samples (each set of time points) to rinse the column.   453 
 454 
9.2. To start the run, highlight all File Names in the Sequence. From the menu bar, select Actions 455 
> Run Sequence > OK. 456 
 457 
10. Consolidating files and searching for tentative annotations on MZmine 2.53.  458 
 459 
10.1. Open MZmine and import the ‘.raw’ output files from step 9.1. From the menu bar, select 460 

Raw Data Methods > Raw Data Import. Select files corresponding to the samples. 461 

 462 

10.2. Construct a list of peaks distinguishing between MS1 and MS2 scans. From the menu bar, 463 

Raw Data Methods > Feature Detection > MS/MS Peaklist Builder. Relevant settings include m/z 464 

Window set to 0.01 and Time Window set to the length of the run. Under set filters, select 465 

Negative as Polarity and Centroided as the Spectrum Type.  466 

 467 

10.3. From the menu bar, go to Feature List Methods > Feature Detection > Peak Extender. Set 468 

m/z Tolerance to 0.005 m/z or 10 ppm and Minimum Height to 1E3. This step will create fully 469 

fleshed-out peaks. 470 

 471 

10.4 Remove duplicate peaks. Go back to Feature List Methods > Filtering > Duplicate Peak 472 

Filter. Relevant settings include m/z Tolerance set to 0.005 m/z or 10 ppm and the RT Tolerance 473 

set to 5 min. 474 

 475 

10.5. To align peaks within similar data files (i.e., those of triplicate reactions), go back to Feature 476 

List Methods > Normalization > Retention Time Calibration. Be sure to process triplicate samples 477 

together and leave out blanks. Relevant settings include m/z Tolerance set to 0.005 m/z or 10 478 

ppm, RT Tolerance set to 3 min absolute (min), and Minimum Standard Intensity set to 1E3. 479 

 480 

10.6. Align peaks from all files by m/z and retention time from Feature List Methods > Alignment 481 

> RANSAC Aligner. Set m/z Tolerance to 0.005 m/z or 10 ppm, RT Tolerance and RT Tolerance 482 



   

After Correction to 44 and 39 min, respectively, RANSAC Iterations to 0, Minimum Number of 483 

Points to 10%, and Threshold Value to 1. Tick the option Require Same Charge State. 484 

 485 

10.7. Correct for any data points that may have been lost in prior steps in Feature List Methods 486 

> Gap Filling > Peak Finder. Relevant settings include Intensity Tolerance set to 50%, m/z 487 

Tolerance set to 0.005 m/z or 10 ppm, and RT Tolerance set to 3 min. Enable RT correction. 488 

 489 

11. Calculating negative mode masses of 13C-labeled glucose-derived metabolites and 490 
searching for the m/z features of these analytes in filtered data.  491 
 492 
11.1. Calculate the masses of 13C-labeled metabolites from glucose metabolism for the targeted 493 
search.  494 
 495 
11.1.1. Calculate the monoisotopic mass of each target compound from the number of atoms in 496 
the compound’s molecular formula and the monoisotopic masses of each element20. 497 
 498 
11.1.2. Calculate the compound’s negative mode mass [M-H]- by subtracting the mass of 1 proton 499 
(1.007276 Da) from the monoisotopic mass. This is the mass detected by negative mode MS 500 
detection after molecules are stripped of a hydrogen ion during ionization.  501 
 502 
11.1.3. From the negative mode mass, calculate the mass of the 13C-incorporating metabolite. 503 
Here, the masses of isotopologues that maximally incorporate glucose-derived 13C-labels were 504 
calculated.  505 
 506 
11.2. Use calculated masses of 13C-labeled metabolites to search and annotate m/z features from 507 
MZmine results. For each possible hit, calculate the mass error (ppm) using the following 508 
equation:  509 
 510 

𝒑𝒑𝒎 𝒆𝒓𝒓𝒐𝒓 =  
(
𝒎
𝒛
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 𝒙 𝟏𝟎𝟔 511 

 512 
NOTE: Experimental m/z values with <15 ppm mass error were considered as putative 513 
annotations in the current analysis. 514 
 515 
11.3. Manually check spectra of putative annotations on a quality browser to confirm 516 
annotations.  517 
 518 
11.3.1. Open Roadmap > Qual Browser. From the Tool Bar, Open Raw File to import raw MS data 519 
of each sample.  520 
 521 
11.3.2. Draw a line under the desired range of retention times (i.e., corresponding to the putative 522 
annotation) on the total ion chromatogram (top panel) to view a mass spectrum (bottom panel). 523 



   

Right-click on the spectrum and input a range of masses that encompass the target analyte’s m/z. 524 
Check whether the putative annotations have distinct peak signals that are appreciably above 525 
the noise (Supplemental Figure 2). 526 
 527 
11.4. Calculate the average peak areas and the standard errors of positive annotations across 528 
biological replicates for each time point. Visualize the data (i.e., on a bar graph) to observe trends 529 
in glucose metabolism.  530 
 531 
REPRESENTATIVE RESULTS:  532 
To quantify the lysate-based cell-free synthesis of common fermentation products from glucose, 533 
lysates derived from strains grown in 2xYPTG media were fed 100 µM glucose as a primary carbon 534 
source8. Reactions were stopped over a 24 h time course by protein acidification. Filtered 535 
supernatants containing pyruvate, succinate, lactate, formate, acetate, and ethanol produced 536 
from glucose catabolism were loaded onto the autosampler module of a HPLC system equipped 537 
with a RID module. Vials with filtered mixtures of fermentative end-products and glucose at 1.17 538 
µM, 2.34 µM, 4.69 µM, 9.38 µM, 18.75 µM, 37.50 µM, 75 µM, and 150 µM concentrations in S30 539 
buffer were loaded onto the instrument as standards. Analytes were eluted isocratically from an 540 
HPLC column to the RID. Peaks for glucose, succinate, lactate, formate, acetate, and ethanol 541 
within the 1 to 150 µM range could be resolved by RID. Peak areas for glucose were derived by 542 
manual integration from the RID data for time course and standard curve samples. Extracted 543 
peak areas for succinate, lactate, formate, acetate, and ethanol were taken from automatically 544 
integrated signals. All standard curves (peak area vs. known concentration) had R2 values >0.99 545 
and were linear throughout the range of concentrations used here.   546 
 547 
Molar concentrations for all target analytes were calculated from their respective standard 548 
curves. Glucose was consumed within the first 3 h of the reaction and mainly fermented to lactate 549 
(Figure 2A,B). Ethanol accumulation also significantly occurred within the first 3 h of the reaction 550 
and stopped thereafter (Figure 2C). The observation of significant lactate and ethanol production 551 
with significant glucose consumption after 3 h was not unprecedented since lactate and ethanol 552 
production pathways allow the regeneration of 1 net mol NAD+ from glycolytic NADH required 553 
for continued glucose consumption through glycolysis (Figure 1). Lactate and ethanol can thus 554 
be considered as the major fermentation end-products in lysate-based cell-free glucose 555 
metabolism. Acetate was initially present in the reactions as a component of the S30 buffer and 556 
unexpectedly only accumulated due to metabolism after 6 h when glucose consumption had 557 
slowed down (Figure 2D). This result suggests that acetate fermentation does not necessarily 558 
enable rapid glycolytic flux in earlier time points. Meanwhile, formate and succinate were 559 
synthesized as minor fermentation products (Figure 2E,F). Altogether, the method enabled the 560 
absolute quantification of sugar substrate depletion and fermentative product formation in E. 561 
coli S30 lysates.  562 
 563 
MS detection to profile lysate glucose metabolism specifically was applied here. Lysates derived 564 
from strains grown in 2xYPTG media were fed 13C6-glucose as a carbon source. CFME reactions 565 
were run in triplicate for 0 h, 1 h, 2 h, and 3 h. Samples from each timepoint were loaded on an 566 
LC system equipped with a reversed-phase column and coupled to Fourier transform and ion trap 567 



   

mass spectrometers. Negative ion mode spectra were obtained and processed to analyze organic 568 
acids, sugar phosphates, and amino acids. Calculated theoretical masses of 13C-labeled species 569 
belonging to central carbon metabolism were searched to identify specifically glucose-derived 570 
compounds. Based on the utilized source strain cultivation conditions and previous reports of 571 
active pathways in E. coli CFME, it is assumed here that the lysate proteome comprises a 572 
metabolic network that feeds glucose into glycolytic fermentation, the pentose phosphate 573 
pathway, and possibly amino acid anabolism5,6,7,8,14 (Figure 1). Therefore, the search was 574 
narrowed down to members of these pathways, of which 16 metabolites incorporating glucose-575 
derived 13C labels were unambiguously annotated (Supplemental Table 1).  576 
 577 
13C6-glucose was observably consumed through glycolysis, as evidenced by the fluctuations in 578 
glycolytic intermediate abundances (Figure 3A–E). Consistent with the HPLC-RID data, glucose 579 
accumulated to 13C3-lactate and was also fermented to 13C3-succinate within the first 3 h of the 580 
reaction (Figure 4A,B). The formation of 13C3-succinate isotopologue supports the proposed 581 
model of lysate glucose metabolism (Figure 1), where succinate is likely to be generated by the 582 
carboxylation of 3-carbon phosphoenolpyruvate (PEP) molecule and not from the entry of a 2-583 
carbon acetyl-CoA molecule to the TCA cycle. Activation of the TCA cycle has been assumed in 584 
previous CFME studies, but other 13C-labeled intermediates of TCA were not detected here8,19,21. 585 
13C3-aspartate synthesis however occurred within the first h and was consumed, reinforcing the 586 
idea that PEP is directly converted to oxaloacetate (Figure 1, Figure 6C). The data are reflective 587 
of a lysate proteome from source strains harvested during fermentative growth on glucose-rich 588 
media (2xYPTG). This would further imply that the rest of the TCA enzymes not participating in 589 
succinate production form an oxidative TCA branch (Figure 1). None of the metabolites in this 590 
pathway, however, were detected, possibly because high concentrations of glutamate added to 591 
the CFME reaction as a salt counterion prevent the progression of this branch.  592 
 593 
The HPLC-RID data is additionally complemented by the lack of 13C2-acetate detection within the 594 
3 h reaction timeframe suggesting no build-up of acetate from glucose up to 3 h (Figure 2B). 595 
However, the direct precursor of acetate, acetyl-phosphate (acetyl-P), accumulated, suggesting 596 
that the Pta arm of the Pta-AckA pathway for acetate synthesis from acetyl-CoA is active (Figure 597 
4C,D). The AckA catalyzed dephosphorylation of 13C2-acetyl-P to 13C2-acetate likely does not occur 598 
within this timeframe due to acetate being a major component of the S30 buffer used in the 599 
reactions (Figure 1, Figure 2B).  600 
 601 
The incorporation of 13C6-glucose-derived carbons to sugar phosphates 6-602 
phosphogluconolactone (6PGL), 6-phosphogluconate (6PG), ribulose-5-phosphate (Ru5P), and 603 
sedoheptulose-7-phosphate (S7P) was also observed (Figure 5). These results confirm the 604 
participation of the pentose phosphate pathway in lysate glucose metabolism and likely feeds 605 
13C9-tyrosine synthesis, which has been suggested before by a proteomic study, while also 606 
providing a precursor for 13C5-histidine production (Figure 6A,B)7. Labeled phenylalanine and 607 
tryptophan were not observed here, and neither were most of the essential amino acids. 608 
However, this is not entirely surprising since amino acid anabolism is likely to be enriched in 609 
lysates derived from cells grown in nutrient-starved conditions or at the stationary phase7,22. 610 
Moreover, the data thus far suggests that intermediates of glycolysis and fermentation are 611 



   

funneled towards cofactor regenerating end reactions, which must preclude the synthesis of 612 
many amino acids derived from glyceraldehyde-3-phosphate, pyruvate, and acetyl-CoA (i.e., 613 
glycine, cysteine, serine, alanine, valine, leucine, and lysine) (Figure 1). As mentioned, 13C3-614 
aspartate was produced within the first hour, whereas aspartate derived 13C-incorporating amino 615 
acids (i.e., threonine, isoleucine, methionine, and asparagine) were not observed possibly 616 
because glucose-derived aspartate participates in fermentation (Figure 1, Figure 6C). Lastly, flux 617 
towards labeled glutamate and amino acids derived from glutamate may have been impeded by 618 
high levels of glutamate in the reaction environment (Figure 1).   619 
 620 
FIGURE AND TABLE LEGENDS:  621 
Figure 1: A putative metabolic model of lysates derived from E. coli BL21DE3-Star growing 622 
exponentially in high glucose concentrations. Intermediates and end-products of glycolysis 623 
(green), the pentose phosphate pathway (dark orange), and fermentative pathways (blue) from 624 
acetyl-CoA have been reported in lysate-based CFME. The presence of succinate fermentation 625 
implies the activation of the oxidative TCA branch (gray). Amino acid anabolism (gold) in lysates 626 
is not well-defined and is investigated here. 627 
 628 
Figure 2: HPLC-RID data for glucose consumption and fermentative end-product synthesis in 629 
CFME reactions prepared with E. coli crude extracts. (A) Glucose consumption and (B) lactate, 630 
(C) ethanol, (D) acetate, (E) formate, and (F) succinate production in CFME reactions were 631 
monitored over 24 h. Average mM concentrations and error bars (SE) quantified with standard 632 
curves are presented (n = 3). 633 

 634 
Figure 3: Time course trends of 13C6-glucose and 13C-labeled glycolytic intermediates in E. coli 635 
lysate CFME. Relative abundances of (A) 13C6-glucose, (B) 13C6-glucose-6-phosphate/fructose-6-636 
phosphate, (C) 13C6-fructose-1,6-bisphosphate, (D) 13C3-glyceraldehyde-3-637 
phosphate/dihydroxyacetone phosphate, and (E) 13C6-pyruvate in CFME reactions over 3 h. Raw 638 
peak areas extracted by mzMINE software were used to calculate averages and error bars (SE) 639 
for positive annotations (n = 3). 640 
 641 
Figure 4: Time course trends of intermediates and end-products in 13C6-glucose fermentation 642 
in E. coli lysate CFME. Relative abundances of (A) 13C3-lactate, (B) 13C3-succinate, (C) 13C2-acetyl-643 
phosphate, and (D) 13C2-acetyl-CoA in CFME reactions over 3 h. Raw peak areas extracted by 644 
mzMINE software were used to calculate averages and error bars (SE) for positive annotations (n 645 
= 3). 646 
 647 
Figure 5: Time course trends of 13C6-glucose derived pentose phosphate pathway intermediates 648 
in E. coli lysate CFME. Relative abundances of (A) 13C6-6-phosphogluconolactone, (B) 13C6-6-649 
phosphogluconate, (C) 13C5-ribulose-5-phosphate, and (D) 13C7-sedoheptulose-7-phosphate over 650 
3 h. Raw peak areas extracted by mzMINE software were used to calculate averages and error 651 
bars (SE) for positive annotations (n = 3). 652 
 653 
Figure 6: Time course trends of detected 13C6-glucose derived amino acids in E. coli lysate CFME. 654 
Relative abundances of (A) 13C9-tyrosine, (B) 13C5-histidine, and (C) 13C3-aspartate over 3 h. Raw 655 



   

peak areas extracted by mzMINE software were used to calculate averages and error bars (SE) 656 
for positive annotations (n = 3). 657 
 658 
Supplemental Figure 1: Representative HPLC-RID chromatogram showing peaks for major 659 
fermentative products in a CFME reaction incubated at 37 ˚C for 24 h. Glucose, succinate, lactate, 660 
formate, acetate, and ethanol peaks are sufficiently distinguishable by their retention times on 661 
an HPLC column during isocratic elution with 5 mM sulfuric acid solvent. 662 
 663 
Supplemental Figure 2: Representative mass spectra for 13C-labeled metabolites, specifically (A) 664 
lactate,(B) glucose, and (C) 6-phosphogluconate (6PG) in a CFME reaction incubated at 37 ˚C for 665 
1 h. 666 
 667 
Supplemental Table 1: List of detected 13C-labeled metabolites, retention times (aligned across 668 
samples using MZmine), theoretical fully 13C-labeled negative mode m/z values, m/z values of 669 
detected features, and calculated mass errors. 670 
 671 
DISCUSSION:  672 
The outlined HPLC-RID approach can be used to successfully quantify sugar substrate 673 
consumption and subsequent conversions to major organic acid and alcohol products of lysate 674 
central metabolism over time. Furthermore, this protocol employs a simple isocratic method 675 
using a single mobile phase, requires minimal sample preparation, and allows a simple targeted 676 
downstream analysis. Analytes measured by the HPLC-RID method are distinguished solely by 677 
their retention times, and therefore their interactions with the selected column resin. The HPLC  678 
column utilized here was particularly designed to separate carbohydrates, organic acids, and 679 
alcohols by combining size-exclusion and ligand exchange (i.e., ion-moderated partition 680 
chromatography). The described method is, therefore, useful for more targeted analysis of 681 
carbohydrate substrates and select end-products of glucose fermentation pathways which are 682 
expected to primarily facilitate and energize lysate-based bio-transformations8,15,21. However, 683 
this protocol does not account for the activation of other metabolic pathways in cell extracts. 684 
Pipelines employing other chromatographic separation techniques (i.e., hydrophilic interaction 685 
chromatography), gradient elution methods, more complicated sample preparation (i.e., 686 
derivatization), and different optical detectors (e.g., ultraviolet light or evaporative light 687 
scattering detectors) could be used to detect other metabolites such as amino acids and sugar 688 
phosphates23,24. Alternatively, a global approach to studying lysate metabolism can be taken 689 
using LC-MS/MS.  690 
 691 
The described LC-MS/MS method is a single workflow for measuring and identifying a broader 692 
range of metabolites. LC-MS/MS is a state-of-the-art analytical tool for metabolome profiling 693 
because of its sensitivity and ability to distinguish metabolites by retention time and m/z ratios 694 
with high resolution16. With a focus on central carbon metabolic pathways and amino acid 695 
anabolism, negative mode MS/MS was implemented to specifically detect polar organic acids, 696 
sugar phosphates, and amino acids. Coupled with a nano-liquid chromatography technique, the 697 
method provides high sensitivity for detecting small molecules in the complex lysate 698 
background17. In terms of profiling lysate-based CFME metabolism, however, a limitation of the 699 



   

described LC-MS/MS protocol is its lower detection limit of 50 m/z, which precludes the 700 
measurement of ethanol, a major product in lysate glucose metabolism, as well as formate, which 701 
is both otherwise easily quantified by the detailed HPLC-RID method. Compared to LC-MS/MS, 702 
HPLC-RID has the additional advantage of relative accessibility in terms of cost and difficulty. To 703 
the latter point, troubleshooting the LC-MS/MS method described here may require some degree 704 
of expertise in mass spectrometry. Nonetheless, MS detection has uniquely appealing 705 
applications over RID as it can additionally distinguish labeled isotopes in metabolomes, an 706 
excellent technique for understanding carbon movement from supplemented substrates through 707 
the complex lysate metabolic network18. Such an approach was applied here by supplementing 708 
reactions with 13C6-glucose and analyzing the relative abundance values of downstream 13C-709 
incorporating metabolites. The analysis allowed the definition of active and inactive pathways, 710 
supporting previously reported assumptions and providing new insights about metabolic flux in 711 
lysates. Modifications can also be made within the method for specific analyses. For example, 712 
standard solutions of 13C-labeled target compounds can be analyzed along with samples to 713 
achieve absolute quantitative measurements of glucose-derived molecules over time and make 714 
conclusions about flux distributions. Better detection of positively charged compounds can also 715 
be enabled within the current workflow by running sequences with .meth files adjusted for 716 
positive mode detection.  717 
 718 
Analytical sampling in both described methods is conveniently automated, ensuring high 719 
reproducibility. Moreover, smooth analytical runs can be expected as long as proper instrument 720 
handling practices and maintenance are observed. When using these tools to analyze CFME 721 
reactions, more critical considerations should be made upstream and downstream of sampling. 722 
During sample preparation, it is important that time-course controls are representative of time-723 
zero. Here, proteins were precipitated in lysates by acidification to stop metabolic reactions. For 724 
time-zero samples, the acid solvent was combined with lysate prior to adding the reaction mix 725 
containing glucose. Acidification with trichloroacetic acid effectively ensured that glucose is not 726 
metabolized at time-zero, as shown in the HPLC-RID data (Figure 2). While a similar procedure to 727 
quench glucose metabolism was performed in the reported LC-MS/MS analysis, 13C-labeled 728 
metabolites were detected in time-zero samples, albeit at significantly low abundance values 729 
relative to samples extracted at later timepoints. Moreover, these observations were limited to 730 
intermediates of glycolysis. The data suggest that the reactions retain some degree of glycolytic 731 
activity after acidification with the extraction solvent that is detected by this highly sensitive 732 
method. The extent of this activity, however, should be quantified. A previous study reported 733 
that acidic extraction solvents may not sufficiently quench intermediate glycolytic reactions but 734 
can stop significant glucose consumption10. While this remains to be further investigated in the 735 
system used here, drastic changes in relative abundance values between time-zero and later 736 
timepoint samples can be interpreted as trends in glucose metabolism. Exploring alternative 737 
quenching methods, however, is recommended in similar applications, specifically for obtaining 738 
absolute quantities of metabolic intermediates10. Furthermore, good practices during 739 
downstream software analyses should also be observed. Consistency is imperative when 740 
manually integrating peak areas from RID signals to reduce human error. Manual integration 741 
should also be applied to peak areas of standards whenever manually integrated peak areas are 742 
being used to quantify metabolite concentrations in samples. Throughout the targeted LC-743 



   

MS/MS analysis, tentative annotations from MZmine analysis should be validated by manual 744 
peak checking using an MS quality browser, and m/z features should only be annotated when 745 
calculated mass errors are acceptable. Here, these analyses were performed manually for a 746 
limited set of targets since comprehensive and robust software for isotope searching is not yet 747 
established. However, such automated methods for searching 13C labeled metabolites are 748 
currently emerging and would streamline more complicated analyses as well, like profiling lysates 749 
beyond central carbon metabolism25. 750 
 751 
Advanced liquid chromatography is a robust and widely applied method for separating small 752 
molecules in complex metabolic mixtures11. The described methods couple this separation 753 
technique with the refractive index or mass spectrometric detection to successfully analyze 754 
metabolite conversions in lysate-based CFME reactions. HPLC-RID and LC-MS/MS are individually 755 
powerful tools for profiling active lysate metabolism, and their complementarity can further be 756 
leveraged to address each technique’s inherent limitations. The reported methods enable the 757 
application and development of CFME as they can be utilized to understand lysate metabolism, 758 
monitor improvements in targeted metabolite conversions, and elucidate alterations to 759 
metabolite flux when manipulating lysate metabolism. 760 
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Supplemental Table 1. 

Metabolite Aligned 
Retention 

Time 

Max. No. 
Glucose-
derived 
Carbons 

13C labeled 
m/z 

(theoretical) 

Detected 
m/z 

Mass Error 
(ppm) 

Pyruvate 14.12 3 90.0189691 90.0182423 8.07386736 

Lactate 13.07 3 92.0346181 92.0340567 6.09947799 

Succinate 14.52 3 120.029534 120.028628 7.55036581 

Aspartate 13.30 3 135.040433 135.040497 0.47173434 

Acetyl-P 20.88 2 140.986985 140.986189 5.64597728 

Histidine 12.86 5 159.079201 159.077028 13.6628837 

Glyceraldehyde-3-phosphate/ 
Dihydroxyacetone phosphate 

34.23 3 172.00095 172.00017 4.53856615 

Glucose 14.48 6 185.076514 185.075593 4.98060011 

Tyrosine 14.20 9 189.097218 189.095695 8.05604078 

Ribulose-5-phosphate 19.21 5 234.02888 234.027845 4.42525765 

6-phosphogluconolactone 24.08 6 263.027195 263.026148 3.98376788 

Glucose-6-phosphate/ 
Fructose-6-phosphate 

14.41 6 265.042845 265.041793 3.97069804 

6-phosphogluconate 27.19 6 281.03776 281.036581 4.19826553 

Sedoheptulose-7-phosphate 18.44 5 296.056811 296.055299 5.1058181 

Fructose-1,6-bisphosphate 24.55 6 345.009176 345.007811 3.95796794 

Acetyl-CoA 28.91 2 810.125302 810.123184 2.61456579 
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Please note that the attached manuscript file has been formatted to fit the journal standard. 
Some comments to be addressed are included in the manuscript. Please review and revise 
accordingly. 
 
Responses are colored in blue. 
 
1. Please revise the text to avoid the use of any personal pronouns (e.g., "we", "you", "our" 
etc.). 
 
All sentences initially written in first person have been revised to third person. 
 
2. JoVE cannot publish manuscripts containing commercial language. This includes trademark 
symbols (™), registered symbols (®), and company names before an instrument or reagent. 
Please remove all commercial language from your manuscript and use generic terms instead. 
All commercial products should be sufficiently referenced in the Table of Materials. 
For example: OpenLab, Kinetex, Xcalibur, Aminex HPX-87H, etc. 
 
All commercial language has been removed from the text and replaced with generic terms. An 
updated table of contents, now with the names of software that are trademarked or registered, 
can be found at the end of the revised file. 
 
3. Supplemental Figure 1/ 2: Please remove the figure legends form the uploaded figure. 
 
We resubmitted these figures as EPS files without legends.  
 
4. Please include a Disclosures section, providing information regarding the authors’ competing 
financial interests or other conflicts of interest. If authors have no competing financial interests, 
then a statement indicating no competing financial interests must be included. 
 
A disclosures section has been added (line 771). 
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ARTICLE AND VIDEO LICENSE AGREEMENT 

612542.6 For questions, please contact us at submissions@jove.com or +1.617.945.9051. 

Title of Article: 

Author(s): 

Item 1: The Author elects to have the Materials be made available (as described at 
http://www.jove.com/publish) via: 

 Standard Access  Open Access

Item 2: Please select one of the following items: 

 The Author is NOT a United States government employee.

 The Author is a United States government employee and the Materials were prepared in the
course of his or her duties as a United States government employee. 

ARTICLE AND VIDEO LICENSE AGREEMENT 

1. Defined Terms. As used in this Article and Video
License Agreement, the following terms shall have the
following meanings: “Agreement” means this Article and
Video License Agreement; “Article” means the article
specified on the last page of this Agreement, including any
associated materials such as texts, figures, tables, artwork,
abstracts, or summaries contained therein; “Author”
means the author who is a signatory to this Agreement;
“Collective Work” means a work, such as a periodical issue,
anthology or encyclopedia, in which the Materials in their
entirety in unmodified form, along with a number of other
contributions, constituting separate and independent
works in themselves, are assembled into a collective whole; 
“CRC License” means the Creative Commons Attribution-
Non Commercial-No Derivs 3.0 Unported Agreement, the
terms and conditions of which can be found at:
http://creativecommons.org/licenses/by-nc-
nd/3.0/legalcode; “Derivative Work” means a work based
upon the Materials or upon the Materials and other pre-
existing works, such as a translation, musical arrangement,
dramatization, fictionalization, motion picture version,
sound recording, art reproduction, abridgment,
condensation, or any other form in which the Materials may 
be recast, transformed, or adapted; “Institution” means
the institution, listed on the last page of this Agreement, by
which the Author was employed at the time of the creation 
of the Materials; “JoVE” means MyJove Corporation, a
Massachusetts corporation and the publisher of The Journal 
of Visualized Experiments; “Materials” means the Article
and / or the Video; “Parties” means the Author and JoVE;
“Video” means any video(s) made by the Author, alone or
in conjunction with any other parties, or by JoVE or its
affiliates or agents, individually or in collaboration with the
Author or any other parties, incorporating all or any portion 

of the Article, and in which the Author may or may not 
appear. 
2. Background. The Author, who is the author of the 
Article, in order to ensure the dissemination and protection 
of the Article, desires to have the JoVE publish the Article
and create and transmit videos based on the Article. In
furtherance of such goals, the Parties desire to memorialize 
in this Agreement the respective rights of each Party in and 
to the Article and the Video.
3. Grant of Rights in Article. In consideration of JoVE 
agreeing to publish the Article, the Author hereby grants to 
JoVE, subject to Sections 4 and 7 below, the exclusive,
royalty-free, perpetual (for the full term of copyright in the
Article, including any extensions thereto) license (a) to
publish, reproduce, distribute, display and store the Article
in all forms, formats and media whether now known or
hereafter developed (including without limitation in print,
digital and electronic form) throughout the world, (b) to
translate the Article into other languages, create
adaptations, summaries or extracts of the Article or other
Derivative Works (including, without limitation, the Video)
or Collective Works based on all or any portion of the Article 
and exercise all of the rights set forth in (a) above in such
translations, adaptations, summaries, extracts, Derivative
Works or Collective Works and(c) to license others to do any 
or all of the above. The foregoing rights may be exercised in 
all media and formats, whether now known or hereafter
devised, and include the right to make such modifications
as are technically necessary to exercise the rights in other
media and formats. If the “Open Access” box has been
checked in Item 1 above, JoVE and the Author hereby grant
to the public all such rights in the Article as provided in, but
subject to all limitations and requirements set forth in, the
CRC License.
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ARTICLE AND VIDEO LICENSE AGREEMENT 

612542.6 For questions, please contact us at submissions@jove.com or +1.617.945.9051. 

4. Retention of Rights in Article. Notwithstanding 
the exclusive license granted to JoVE in Section 3 above, the 
Author shall, with respect to the Article, retain the non-
exclusive right to use all or part of the Article for the non-
commercial purpose of giving lectures, presentations or
teaching classes, and to post a copy of the Article on the
Institution’s website or the Author’s personal website, in
each case provided that a link to the Article on the JoVE
website is provided and notice of JoVE’s copyright in the
Article is included. All non-copyright intellectual property
rights in and to the Article, such as patent rights, shall
remain with the Author.
5. Grant of Rights in Video – Standard Access. This
Section 5 applies if the “Standard Access” box has been
checked in Item 1 above or if no box has been checked in
Item 1 above. In consideration of JoVE agreeing to produce,
display or otherwise assist with the Video, the Author
hereby acknowledges and agrees that, Subject to Section 7
below, JoVE is and shall be the sole and exclusive owner of
all rights of any nature, including, without limitation, all
copyrights, in and to the Video. To the extent that, by law,
the Author is deemed, now or at any time in the future, to
have any rights of any nature in or to the Video, the Author
hereby disclaims all such rights and transfers all such rights
to JoVE. 
6. Grant of Rights in Video – Open Access. This
Section 6 applies only if the “Open Access” box has been
checked in Item 1 above. In consideration of JoVE agreeing
to produce, display or otherwise assist with the Video, the
Author hereby grants to JoVE, subject to Section 7 below, 
the exclusive, royalty-free, perpetual (for the full term of
copyright in the Article, including any extensions thereto)
license (a) to publish, reproduce, distribute, display and
store the Video in all forms, formats and media whether
now known or hereafter developed (including without
limitation in print, digital and electronic form) throughout
the world, (b) to translate the Video into other languages,
create adaptations, summaries or extracts of the Video or
other Derivative Works or Collective Works based on all or
any portion of the Video and exercise all of the rights set
forth in (a) above in such translations, adaptations,
summaries, extracts, Derivative Works or Collective Works
and (c) to license others to do any or all of the above. The 
foregoing rights may be exercised in all media and formats,
whether now known or hereafter devised, and include the
right to make such modifications as are technically
necessary to exercise the rights in other media and formats. 
For any Video to which this Section 6 is applicable, JoVE and
the Author hereby grant to the public all such rights in the
Video as provided in, but subject to all limitations and
requirements set forth in, the CRC License.
7. Government Employees. If the Author is a United
States government employee and the Article was prepared
in the course of his or her duties as a United States
government employee, as indicated in Item 2 above, and
any of the licenses or grants granted by the Author
hereunder exceed the scope of the 17 U.S.C. 403, then the
rights granted hereunder shall be limited to the maximum

rights permitted under such statute. In such case, all 
provisions contained herein that are not in conflict with 
such statute shall remain in full force and effect, and all 
provisions contained herein that do so conflict shall be 
deemed to be amended so as to provide to JoVE the 
maximum rights permissible within such statute. 
8. Protection of the Work. The Author(s) authorize
JoVE to take steps in the Author(s) name and on their behalf
if JoVE believes some third party could be infringing or
might infringe the copyright of either the Author’s Article
and/or Video.
9. Likeness, Privacy, Personality. The Author hereby
grants JoVE the right to use the Author’s name, voice,
likeness, picture, photograph, image, biography and
performance in any way, commercial or otherwise, in
connection with the Materials and the sale, promotion and 
distribution thereof. The Author hereby waives any and all
rights he or she may have, relating to his or her appearance 
in the Video or otherwise relating to the Materials, under
all applicable privacy, likeness, personality or similar laws.
10. Author Warranties. The Author represents and
warrants that the Article is original, that it has not been
published, that the copyright interest is owned by the
Author (or, if more than one author is listed at the beginning 
of this Agreement, by such authors collectively) and has not 
been assigned, licensed, or otherwise transferred to any
other party. The Author represents and warrants that the
author(s) listed at the top of this Agreement are the only
authors of the Materials. If more than one author is listed
at the top of this Agreement and if any such author has not
entered into a separate Article and Video License
Agreement with JoVE relating to the Materials, the Author
represents and warrants that the Author has been
authorized by each of the other such authors to execute this 
Agreement on his or her behalf and to bind him or her with 
respect to the terms of this Agreement as if each of them
had been a party hereto as an Author. The Author warrants 
that the use, reproduction, distribution, public or private
performance or display, and/or modification of all or any
portion of the Materials does not and will not violate,
infringe and/or misappropriate the patent, trademark,
intellectual property or other rights of any third party. The
Author represents and warrants that it has and will
continue to comply with all government, institutional and
other regulations, including, without limitation all
institutional, laboratory, hospital, ethical, human and
animal treatment, privacy, and all other rules, regulations,
laws, procedures or guidelines, applicable to the Materials,
and that all research involving human and animal subjects
has been approved by the Author's relevant institutional
review board.
11. JoVE Discretion. If the Author requests the
assistance of JoVE in producing the Video in the Author’s
facility, the Author shall ensure that the presence of JoVE
employees, agents or independent contractors is in
accordance with the relevant regulations of the Author's
institution. If more than one author is listed at the
beginning of this Agreement, JoVE may, in its sole
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discretion, elect not take any action with respect to the 
Article until such time as it has received complete, executed 
Article and Video License Agreements from each such 
author. JoVE reserves the right, in its absolute and sole 
discretion and without giving any reason therefore, to 
accept or decline any work submitted to JoVE. JoVE and its 
employees, agents and independent contractors shall have 
full, unfettered access to the facilities of the Author or of 
the Author’s institution as necessary to make the Video, 
whether actually published or not. JoVE has sole discretion 
as to the method of making and publishing the Materials, 
including, without limitation, to all decisions regarding 
editing, lighting, filming, timing of publication, if any, 
length, quality, content and the like.  
12. Indemnification. The Author agrees to indemnify
JoVE and/or its successors and assigns from and against any 
and all claims, costs, and expenses, including attorney’s
fees, arising out of any breach of any warranty or other
representations contained herein. The Author further
agrees to indemnify and hold harmless JoVE from and
against any and all claims, costs, and expenses, including
attorney’s fees, resulting from the breach by the Author of
any representation or warranty contained herein or from
allegations or instances of violation of intellectual property
rights, damage to the Author’s or the Author’s institution’s
facilities, fraud, libel, defamation, research, equipment,
experiments, property damage, personal injury, violations
of institutional, laboratory, hospital, ethical, human and
animal treatment, privacy or other rules, regulations, laws,
procedures or guidelines, liabilities and other losses or
damages related in any way to the submission of work to
JoVE, making of videos by JoVE, or publication in JoVE or
elsewhere by JoVE. The Author shall be responsible for, and 
shall hold JoVE harmless from, damages caused by lack of
sterilization, lack of cleanliness or by contamination due to

the making of a video by JoVE its employees, agents or 
independent contractors. All sterilization, cleanliness or 
decontamination procedures shall be solely the 
responsibility of the Author and shall be undertaken at the 
Author’s expense. All indemnifications provided herein 
shall include JoVE’s attorney’s fees and costs related to said 
losses or damages. Such indemnification and holding 
harmless shall include such losses or damages incurred by, 
or in connection with, acts or omissions of JoVE, its 
employees, agents or independent contractors. 
13. Fees. To cover the cost incurred for publication,
JoVE must receive payment before production and
publication of the Materials. Payment is due in 21 days of
invoice. Should the Materials not be published due to an
editorial or production decision, these funds will be
returned to the Author. Withdrawal by the Author of any
submitted Materials after final peer review approval will
result in a US$1,200 fee to cover pre-production expenses
incurred by JoVE. If payment is not received by the
completion of filming, production and publication of the
Materials will be suspended until payment is received.
14. Transfer, Governing Law. This Agreement may be
assigned by JoVE and shall inure to the benefits of any of
JoVE’s successors and assignees. This Agreement shall be
governed and construed by the internal laws of the
Commonwealth of Massachusetts without giving effect to
any conflict of law provision thereunder. This Agreement
may be executed in counterparts, each of which shall be
deemed an original, but all of which together shall be
deemed to me one and the same agreement. A signed copy 
of this Agreement delivered by facsimile, e-mail or other
means of electronic transmission shall be deemed to have
the same legal effect as delivery of an original signed copy
of this Agreement.

Author: Mitchel J. Doktycz

Signature: _________________________________________________ Date: _____________________

Employer: UT-Battelle, LLC

SIgnature: _________________________________________________ Date: _____________________

04/29/2021

04/29/2021CTA Representative
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